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APPLYING FLATCAM FOR PCB CNC MILLING 

FlatCAM takes standard data files from PCB design software packages and converts them into CNC 

milling and drilling GCodes that can be run on a CNC milling machine.  The PCB design can be single 

or double sided. FlatCAM provides the tooling setup to align double sided designs.   FlatCAM also 

provides the board outline profiling GCode and the coding for any cut outs needed within the board 

area. 

FlatCAM up to version 8.5 was created by Juan Pablo Caram but subsequent updates are supported 

by Marius Stanciu.  At the time of this write up the current issue level was 8.991.  The original 

documentation by Juan Pablo Caram describing the application of FlatCAM is to a reasonable 

standard but not always intuitive. This write up is an attempt to clear the mists and is now been 

updated to be based on version 8.991.  The FlatCAM versions after 8.5 are somewhat more 

complicated but do have features that more advanced users might require. 

Overview 

This write up will cover the production of double sided boards and includes details of experiences 

regarding work holding and also milling tool selections.  Single sided board are much less complex to 

produce and can be produced using a cut down version of these details. 

FlatCAM needs Gerber files of the top and bottom copper trackwork and the board profile (.gbr) 

together with Excellon drilling information (.drl).  These are industry standard format files for PCB 

manufacture and any PCB design software will allow export of Gerber and Excellon information.  I 

use the Electrical design module in Fusion 360 for my PCB design (this is based on Autodesk’s 

incorporation of Eagle).   This means in the one package I have 3D design, CNC CAM and PCB design.   

Once the board design in finished in Fusion I can see the design as a 3D model with representations 

of the parts in place. I can then design a housing around this model.   Fusion creates a manufacturing 

ZIP compressed export of all the files needed for third party board manufacture and the contents are 

shown below. 

 

Note that like Fusion, most PCB design software packages will provide many this style of 

manufacturing output.  Most of these files are of lesser interest to hobbyist producing simple 

designs in the home workshop. Should you wish to progress to having the design made by a third 

part manufacturer then this link is a good source of info on the various files. 
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https://www.allaboutcircuits.com/technical-articles/PCB-design-how-to-generate-manufacturing-

files-custom-printed-circuit-

board/#:~:text=The%20most%20widely%20used%20file,that%20contain%20Gerber%2Dformatted%

20data. 

The manufacturing files created by the PCB design package will have their data stored in ASCII 

format unlike a CNC machine which requires GCode format.  FlatCAM provides a conversion process 

between these two formats. The process is not a single click on a button. The Gerber files (.gbr) first 

get converted to an ISO file, then the ISO becomes a CNC ready file before running the CNC 

conversion to GCode.  The Drill file (.drl) follows a similar process.  FlatCAM does streamline this 

process. 

Board Side Naming and Mirroring 

At this stage of the write up it is worth taking time to consider the logistics of the milling process 

that impact on the Gerber data. 

PCB design software has traditionally created the PCB artwork ‘looking down through’ the board 

when viewed from component side.   This is a historic method when components had ‘legs’ that 

passed through the board material to be soldered to the copper tracks on the lower side.   As 

technology has progressed boards became populated on both sides and now with surface mount 

devices there is little to choose as to which is ‘component side’ and which is ‘track side’ except 

perhaps which side you are most likely to see when the board is mounted in the product.   The 

choice of side definition will probably be defined by the designer. He or she will be focussed on such 

things as connectors which will usually be on component or top side.  To avoid confusion I will refer 

to the two sides as ‘top copper’ and ‘bottom copper’ rather than component related.  This is the 

term used by FlatCAM. 

The other aspect to consider is that the bottom copper artwork is as viewed in the design process 

down through the board from the top side.   If the bottom side copper Gerber file is used as a basis 

of the milling code then the machine instructions will be incorrect.   The bottom copper instructions 

must be based on ‘looking at’ the copper artwork from the bottom side not down through from the 

top side.   To correct this the bottom copper artwork must be converted to a mirror image.   This can 

be done in the PCB design package but FlatCAM will also create this process for you. 

Double Sided Milling Process 

This is the simple work flow when producing a milled PCB in the home workshop : - 

The PCB material is clamped on the milling table.    

The top side artwork is milled. 

The various through holes are drilled (component related or mounting holes etc). 

The PCB material is turned over and the bottom side artwork is milled. 

The PCB is profiled with breakout tabs and then broken free from the parent blank material. 

 

The success of this process depends on the ability, when turning the PCB parent material over to run 

the bottom copper, that it aligns correctly with previously milled top side copper.  To do this 

requires the use of tooling pins that will reference the board physically ‘in sync’ for both top copper 

and bottom copper processes. 

https://www.allaboutcircuits.com/technical-articles/pcb-design-how-to-generate-manufacturing-files-custom-printed-circuit-board/#:~:text=The%20most%20widely%20used%20file,that%20contain%20Gerber%2Dformatted%20data
https://www.allaboutcircuits.com/technical-articles/pcb-design-how-to-generate-manufacturing-files-custom-printed-circuit-board/#:~:text=The%20most%20widely%20used%20file,that%20contain%20Gerber%2Dformatted%20data
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FlatCAM has a function to aid this. It allows tooling holes to be positioned as needed and then 

creates drilling CNC GCode for the hole locations.   The process steps as listed above will therefore 

have an added step to do this and this will need completing early in the manufacture. 

The GCode for the tooling holes is created in FlatCAM.  Providing nothing is accidentally changed on 

the mill X0Y0 reference, these tooling holes will allow the board to be flipped from one side to the 

other and maintain top and bottom artwork alignment.  (Clearly for single sided boards this is not 

needed or relevant). 

My process using a vacuum table is slightly modified on this but we will come to this later. 

You can position the tooling holes where you wish but some discussion will now follow about the 

mirroring process. 

Mirroring the Board 

To mirror an object, you need an axis about which to mirror it.  In CNC terms this could be about the 

X or Y axis.   Where you position this axis (I will call it a mirror axis) is important.  If you chose to use 

the left hand vertical edge of the top copper artwork (Y axis) then the bottom side copper will ‘hinge’ 

on this edge like a page in a book and be placed immediately to the left of the top copper. This 

means the PCB blank material would have to be physically moved across on the milling table before 

work on the bottom side could commence.   If you make the mirror line exactly down the centre of 

the PCB artwork then the PCB blank will not move its symmetrical central position as you turn it over 

to mill the bottom copper.  Once you have chosen your mirror axis the tooling pins will make sure 

the alignment is correct and repeatable. 

To create the tooling hole drill code, you specify where you would like the tooling hole(s) to be 

located based on the top side view and your chosen mirror axis.  When you mirror the bottom side 

copper you don’t just get the copper mirrored but you will also get a mirrored position of the tooling 

holes – a chosen hole position creates a mirrored second.  The location of the second mirrored hole 

is created in FlatCAM based on the mirror axis that you have specified.   The mirror axis can be 

specified as an extrapolated line from a point (e.g. X0Y0) or based on a box outline (generally this 

will be the periphery outline of the PCB).  In my experience you need to specify 2 tooling holes for 

FlatCAM to create 2 further ones as mirror locations.  Having two (which will create four after 

mirroring) keeps the board more rigidly held. 

The effect of mirroring takes some understanding.   See the following images.  The first image 

represents the parent material with the PCB layout central on the blank.   A single tooling hole has 

been placed and a Y axis has been chosen as the mirror line. 

You can simulate this.  

Take two pieces of A4 or similar paper which will represent the parent blank PCB material.  Draw a 

rectangle on the first piece of paper to represent the PCB artwork outline.  Draw a single circle to 

represent the tooling hole somewhere outside the PCB artwork area.   Draw a dotted line on the 

artwork to represent the mirror axis.   Make a photocopy of this onto the second piece of paper.   

Superimpose the two pieces of paper so that they represent the top side as viewed and the bottom 

side turned over.   Align the rectangles so they both sit on the mirror axis line and otherwise match.  

Unless you made the mirror axis sit exactly mid way on the rectangle you will find that the two 

sheets of paper must be offset for the tooling holes to align with each other. 
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The next image is the mirrored image representing the Bottom Side as viewed from the bottom 

rather than down through the PCB layout from the Top Side.  This is the view that the milling 

machine needs to mill the Bottom Side artwork. 

 

The next image shows how the tooling hole is mirrored about the mirror axis.   The two tooling holes 

will be drilled from the Tooling drill file created by FlatCAM.   In order for the PCB parent to locate 

onto the two tooling pins the PCB will have to be offset between Top Side and Bottom Side activity 

as shown. 

 

 

If the mirror axis is exactly central on the PCB outline all the problems go away as can be seen in the 

next image. 
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Why is this mirroring set up so important ? 

Suppose you have a fixed frame tooling jig to clamp the parent material down and you do not have 

the artwork geometry centred at X0Y0   When you try to mill the bottom side copper you will have 

to move the frame to match the movement in the parent material relative to the tooling holes.  This 

is hassle and could lead to alignment errors.  

I suggest that in order to create less hassle it is prudent to make the mirror axis symmetrical either in 

X or Y on the PCB design.   In order to facilitate this it is important to make the centre of the PCB 

artwork design equal to the X0,Y0 coordinates.  This can be done in the PCB design package where 

you should be able to set the PCB design origin point.  It can also be done in FlatCAM.   

I mentioned earlier that the mirror can be defined in FlatCAM using a Point (X,Y) or can be from a 

Box.   The Point method is already described where you create a 0,0 reference in the centre of your 

PCB design and use this as the Mirror either about X or about Y.   If you use Box, unless the artworks 

for top and bottom have a common geometry outline designed on them, FlatCAM looks at the 

artwork design and decides where it believes the centre point of the artwork is.  This could be 

completely different between top and bottom copper designs.   If you need to use Box then make 

sure you have an identical border size border positioned in the same relative position on all layers 

of the PCB design. 

 

To help familiarity I suggested that an arbitrary pad is placed on the artwork on both top or bottom 

sides that sits on the axis mirror line you have chosen.   This should be outside of the formal design 

area. This pad gives you a reference that all is well with the mirroring of the bottom side.  This will 

hopefully become clearer when we move into the process in FlatCAM. 
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PCB Design Files Needed 

The file requirements from the PCB design software now breaks down into the following : - 

Board outline (Gerber file *.gbr) 

Top side copper artwork (Gerber file *.gbr) 

Bottom side copper artwork (Gerber file *.gbr) 

Drill file based on top side view (Excellon file *drl) 

 

Note that in order to avoid confusion I find it better to not mirror any of these in the PCB design 

package export.   Keep this instead just as a FlatCAM process. 

Here is a screen shot of the FlatCAM opening screen in version 8.991.  A bit overpowering to say the 

least.   I have never used any of these icons so don’t be put off. 

 

Navigation 

You can move around the FlatCAM screen using your mouse.    

To zoom in and out of the image area you can rotate the mouse wheel.   The image will enlarge or 

shrink centred on the current mouse cursor position on the PCB image. 

To move the viewing area and re-centre the image press and hold down the scroll wheel and drag 

the image to where suits.  You can also use the Zoom Fit button below the File menu. 

Clicking with the left button anywhere in the drawing area will automatically transfer the X and Y co-

ordinate values of that point to the computer clipboard.  This is important to note. 
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Stage – 1 Importing Data 

Because electrical components have traditionally had their physical packages created in an Imperial 

unit’s world, it is likely that your PCB design package will create the layout on an Imperial based grid. 

As parts have got smaller and smaller this does get complicated.   If you wish to process the files 

within FlatCAM as a Metric based activity (perhaps your milling tools are Metric based) then you can 

set the preferences file in FlatCAM to work in Metric.  Go to Edit/Preferences (and be totally 

overawed by the resulting screen.  Yes this really is the first of 8 Preferences tabs).   Before you 

break out into a cold sweat, Select MM or IN and Save. 

 

Create a folder on your computer and store the exported Gerber and Excellon files from the PCB 

design package.  If as from Fusion this is a ZIP file then extract the files into this folder. For the 

purposes of this write up these will be called TOP.gbr, BOTTOM.gbr and DRILL.drl. As you read 

further you will realise that there is an advantage in also importing a BORDER.gbr file having just the 

geometry of the border outline of the finished PCB.  Ideally the board artwork should be designed 

and referenced centrally as X0Y0 but if this is not the case then the next section will show you how 

to modify this. 

Again I recommend that the files exported from the design software should not be mirrored in 

anyway. 

Load the files using the FILE/OPEN dropdown menu to bring in the three GERBER and one EXCELLON 

file.   The later versions of FlatCAM allow you to select and open a number of Gerber files at once 

using Control and clicking them. 

If you now click on the Projects tab you will see the files you have chosen are listed and they will also 

be visible graphically stacked on top of each other in the main graphic area.  Here are some simple 

shapes created from different Gerber files imported into FlatCAM.   There is a PROFILE called 

Plot_1.gbr, a TOP and BOTTOM gerber and a DRILL file. 

Note that all files are superimposed on each other and are all referenced to 0,0 in the bottom left 

hand corner.   The XY readout is at the bottom right edge of the screen.  X and Y values are absolute 

and the Dx and Dy are relative values from the point you last clicked.  The demonstration object is a 

25mm square. 
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Stage 2 – Resetting the PCB X0Y0 Reference 

If you have a design where the Gerber files you have imported are not referenced centrally to X0Y0 

then you need to change this.   Normally the PCB design package would make the bottom left corner 

of the PCB layout equal to X0Y0.  If this corner is nowhere near the X0Y0 and you choose to 

continue, you could have a situation where the code will demand a large movement of the spindle 

from its reference position to the working area for the milling of the board.   This could be outside of 

the milling envelope which is a problem and potentially a tool crash.  Even if the board is referenced 

bottom left at X0Y0 this is not ideal as it has implications for the double sided board mirroring 

process.  Our sample objects are all referenced to 0,0 and need to move them to have 0,0 central in 

the square. 

Follow this sequence : - 

1 If you have not already done this, go to File /Open and navigate to the folder where you 

have the files for the project stored and select and import all the files.   The file images 

will now appear stacked on each other in the Graphic area and will be listed in the 

Project tab listing area. 

2 Click on the PLOT_1.gbr file in the Project tab to make it the file of interest. This file will 

define the maximum outline size of the board to be milled.   Use your mouse to zoom 

into the bottom left and top right corners of the border outline and read off the X and Y 

coordinates of these two points as accurately as you can.   If you know your board size 

from your design activity this helps. 

3 Now for some tricky maths.  You need to move the design to have X0Y0 sat at the dead 

centre of the board. 

Let’s call the bottom left coordinates XL and YL and the top right XR and YR. 
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If you subtract the values (XR – XL) and (YR – YL) this will tell you the difference in 

coordinates between the bottom left and the top right of the BORDER outline.   The 

centre point of the board will be these values divided by 2. 

Let’s assume the simple case where XLYL was at X0Y0.  To move the design to make XLYL 

at the centre of the board we need to create an offset of X = -(XR-XL)/2 and Y = -(YR-

=YL)/2.   This can be entered by going to PROJECT tab, clicking on PLOT_1.gbr and then 

going to the SELECTED tab.   At the bottom of this tab is OFFSET.   In the VECTOR box 

enter the negative values you have calculated.  Note that when entering these values 

you do not need to put the X and Y but solely the numbers with the X first and Y second 

with a comma between. Copy the values you have entered into the box using Control + 

C.  Click the Offset button.   The PLOT_1.gbr will now jump on the display area to sit 

centrally about 0,0.   If it doesn’t then recheck your maths. 

In our example the square is 25mm on each side so we need to (-12.5,-12.5) in the 

Vector box. 

 
 

4 If the co-ordinates for the bottom left corner of the PLOT_1.gbr image were not sitting 

at X0,Y0 the calculation must take this into account.  In effect we must move the image 

in two steps rolled into one.   The first step is to move the corner from wherever it sits 

(let’s call this XW, YW to X0Y0 and then make the shift to sit the image centrally as per 

(3) above.   The maths are similar. 

First the move from XV to YW is a simple negative value of -V and and -W and then the 

move as in (3) making the new equation : - 

 

X Vector move = -(V+((XR-XL)/2) 

Y Vector move = -(W+((YR-YL)/2))  

 

Enter these values in the OFFSET Vector box, copy the values and then click the Offset 

button. 
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5 Repeat this process for the TOP.gbr, BOTTOM.gbr and DRILL.drl.  Because you copied the 

values, time will be saved by copying the values into the Vector box using CTRL+V.   If 

you do not Copy the previous values there is a danger of entering a wrong value.  This 

will mean that the artworks will no longer be correctly stacked one on top of the other. 

Note that the Excellon dialogue window is slightly different but there is still an Offset 

vector section at the end of the settings section. 

 

 
 

6 You should now have all four artworks located centrally and symmetrically about X0Y0 

and stacked on top of each other. 

Stage 3 - Mirroring the BOTTOM.gbr file 

As mentioned earlier, the four images of TOP, BOTTOM, PLOT_1 and DRILL should now be shown in 

the viewing window and should be superimposed on each other and symmetrically positioned about 

X0Y0.   The data for BOTTOM.gbr is as viewed down through the PCB when looking from the top of 

the board and this needs to be reversed (mirrored).  Without this process the GCode file for the 

milling process will be the opposite of what it should be.  It is important to mirror BOTTOM.gbr 

before you continue. 

Click on Tool on the top menu strip (not the Tool tab) and select Double Sided PCB Tool.  This will 

now take you to the Tool tab where the mirroring and tool functions are selected. 

The first selection is to pick the artwork that is to be mirrored in the GERBER box.  Usually this will be 

the BOTTOM.gbr artwork.  Do not press Mirror yet. 

Next select the Mirror axis.  As described earlier this can be done about the X axis or the Y axis.   A 

mirror on the X axis will flip the layout vertically and a Y axis mirror will flip the layout horizontally. 

You must now enter where you want the mirror line to sit on the artwork. Providing the artworks 

have all been referenced to have X0Y0 as the dead centre you can enter 0,0 as the Mirror point and 

press Add and then Mirror 
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Stage 4 - Tooling Pins 

Assuming you have created and entered the mirror axis you now must enter one or two positions for 

tooling pins to hold the PCB in the correct place for BOTTOM and TOP milling.   These can by 

anywhere around the PCB but outside of the artwork geometry.  When marking these positions keep 

in mind the working area of the milling spindle and ensure that the tooling holes are well out of the 

way to avoid a crash. You can click on the position you want to use and then copy the value into the 

Alignment Hole box or manually write the values in the box.  Think about the mirror position 

implications when choosing the locations.   

Enter two values so each X and Y is bracketed and the two values are separated by a comma and you 

put a decimal point in each value [(Xa.a,Ya.a),(Xb.b,Yb.b)].  You can click in the box and edit your 

copied values if you wish to change them. 

Once you have your two chosen locations entered, enter a value for the tooling pin hole diameter 

and press Create Excellon Object.   

If the mirror is symmetrical you will now see four red circles on the display representing the tooling 

pins (the two you entered and the mirrors of these) and these will be symmetrical about the PCB 

mirror line you have chosen (X or Y).   If the mirror axis is not symmetrical on the board geometry 

then the four tooling holes will be asymmetrically placed and you need to recheck things. 

Here is the new view that is created. 

 

 

 

If you check the PROJECT listing tab you will now have an added file called Alignment Drills.  If you 

decide you want to change the locations of the tooling pins you can delete the Alignment Drills file 

and re-do the positions.    

Do not re-mirror the object or the BOTTOM.gbr will no longer be correct. 
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Stage 5 – Gerber Object Dialogue 

You may have already used the lower area of the Gerber Object window to move the artworks to 

X0Y0 using the Offset Vector section.  For this simple introduction we will ignore Non Copper 

Regions and Scale sections.  We will focus instead just on Isolation Routing and later on we will use 

the Boundary Box section. 

1 Go to the PROJECT tab and select TOP.gbr and then the SELECTED tab to see the Gerber 

Object working area. 

 

 
 

2 Enter the milling tool diameter you will use to cut the copper in Tool Dia.  Take care that 

you use the same measurement standard as the Preferences selection. 

3 Set the number of passes that will occur around the geometry and how much each pass 

should overlap the prior one. 

4 Press Generate Isolation Geometry and the objects on screen should now have red 

borders.  In the example this is the pads at each corner and the three diagonal pads 

across the screen and the small square pad. 

5 You now have some further selections to set.  Cut Z is the depth of cut, if you select 

multiple depths then the tool will pass over the artwork a number of times (not usually 

needed for cutting the copper traces), travel Z sets how far off the board the spindle 

starts at before moving down to cut the copper, (ignore tool change and associated Z), 

end move is the amount Z moves up at the end of a run, feed rate is the spindle 

movement speed, feed rate Z is the up and down speed and Spindle speed is what it says 

but chose the fastest speed your spindle can deliver. 

6 Press Generate CNCJob object.  The objects will now change to have a blue outline and 

will show orange tool paths to represent the movement of the spindle.  A new dialogue 

screen will appear.   This confirms the tool chosen and allows you to enter some extra 

GCode commands at the beginning and the end of the GCode file.  (The ones displayed 

are my standard Preferences).  
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7 When completed press Save CNC Code and select a destination and name for the file 

you have created.  This should have a .nc extension. 

8 Go back to the Project tab and.  You will notice in the Project tab that there is now a file 

called TOP.gbr_iso and a CNC file.  

9 Repeat this process for your other Gerber files. 

10 If you have other Gerber files repeat this process until all files have matching ISOs and 

the associated artworks have red outline and blue outlines.  Note that the BOTTOM.gbr 

file does not get changed after mirroring. 

11 There will now be a TOP.gbr_iso_cnc file in the Project tab listing. 

12 Repeat this process for all the other ISO files. 

13 When all ISO_CNC files are ready go back to the Project tab and select the TOP.gbr_cnc 

file. 

14 Go to the Selected tab and you will see a window for the CNC Job Object.   The file name 

should match in the top box. 
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Stage 6 - Excellon Object Window 

The processing of the .drl files is slightly different. 

1 Go to Project and click on the DRILL.drl file.  Go to the Selected tab.  The Selected tab is 

now different being an Excellon Object window.  At the top of the Excellon Object 

window you will see the file name.   If this isn’t DRILL.drl go back to Project and select it 

so it appears in the window. 

2 You should have Plot ticked and Solid ticked only if you want to see a red dot 

representing the holes. 

3 In the Tools window you will have a listing of the tools that have been defined in the 

DRILL.drl file for use drilling the holes on the PCB.  Click on the # symbol to include all 

tools or select the ones you only want to be included for this CNC activity. 

4 Go to the Create CNC job section and note the following : - 

a. Cut Z – this is the depth of cut from the top side copper through the board by all the 

drills you have chosen to use.  It is always a negative value as it is cutting into the 

PCB material from its top surface. 

b. Travel Z – this is the height that the tool tip moves up to while moving rapidly 

around the board to jump to another drilling position. 

c. Feed rate – this is the rate at which the spindle will move while performing the 

drilling process. 

d. Tool Change – untick this for now.   It is the height that the spindle must move to so 

you can access the collet to change a tool in mid process. 

e. Spindle Speed – this is the spindle speed while drilling.   I think you must enter a 

value in this box or you will not be able to create the CNC code.  Choose the fastest 

speed your machine can handle. 

5 Click on Generate 

6 You will now see the pattern of the spindle movement and the order in which holes will 

be drilled and a new file will appear in the Project window – DRILL.drl_cnc. 

7 Select the DRILL.drl_cnc file and go to the Selected tab and you will see a window for the 

CNC Job Object the same as the you had for the Gerber files. 

8 Plot should be ticked and you should check that the tool diameter matches your 

expected size and if you edit this click on Update Plot. 

9 The next two boxes allow you to add GCode commands to the start (Prepend) and finish 

(Append) of the GCode that is going to be created.   These are usually machine specific 

start and end commands and will depend on your machine requirements.  Details of 

these settings are given later in the text. 

10 Tick the Dwell command and leave at 1 second.  This defines how long the program sits 

waiting before running.  This gives you a bit of breathing space to hit the big red button. 

11 Click on Export G-Code and name the resulting file before saving ready for loading into 

your milling machine.  I suggest you give the file a .nc extension name. 

12 Repeat this process for the Alignment Drills file but the depth of cut now needs to be the 

thickness of the PCB material plus (say) 80% of the thickness of the sacrificial material. 
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Stage 7 - Board Outline 

There is a facility within FlatCAM to mill the board profile and leave breakout tabs.  This requires a 

Gerber file that has the outline of the board contained in it.   Alternatively, this can be a standalone 

Gerber that just has the outline geometry.  For this example there is a file called BORDER.gbr. 

1 In project select BORDER.gbr and then click on the Selected tab. 

2 You will see the following image from the Gerber Object details.   

 

 
 

Click on the Cutout Tool button.. 
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3 Make sure that the PROFILE file is shown in the top box.   Set the tool width and depth 

of cut if not already picked up from Preferences. 

4 You might wish to make the cut using multiple depths to save stress on the tool in use. 

5 The Margin box allows a gap between the PCB outer edge geometry and the router path. 

6 Gap Size is the width of the tabs that will be left by the routing. 

7 Automatic Bridge Gaps sets the number of tabs.  There are various selections for this but 

I usually leave it as 4.  If only two tabs are chosen then you have the choice of on which 

axis these will be. 

 

 
 

8 On completion of these four sections you can Generate Rectangular Geometry to create 

the BORDER.gbr_cutout file.  You will see four profile lines appear on the layout to 

represent the cut geometry. 

9 The left hand panel will now change and you should select the PROFLE file now in the 

Geometry section.process now follows as for the other files.   Select the 

BORDER.gbr_cutout in Project and then go to the Selected tab to set the Geometry 

Object.  Check the Parmeters for Tool #1 match the previously entered settings. 

10 Click on Generate CNCJob button. 

11 The image will refresh with a blue band indicating the cut path and showing the tabs.  

Check any additional GCode settings and then click Save CNC as per the other files and 

store the file with an appropriate name. 
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Process Summary 

This write up is long but I hope you will see that the process boils down to having the correct Gerber 

files from your PCB design package and following repeat steps. 

a) Import the Gerber(s) and Excellon file(s) from the PCB design package. 

b) Move all files to be symmetrically centred on X0Y0. 

c) Go to the Double sided PCB tool. 

d) Select the Bottom.gbr 

e) Add the Mirror Axis and Point reference. 

f) Add the Tooling hole(s) and drill size. 

g) Mirror the BOTTOM side. 

h) Create ISO files of each Project file 

i) Create ISO_CNC files of each Project file 

j) Create a GCode output file for each Project file. 

If you are not happy with a file for any reason then go to the Project tab and delete it and re-run the 

processes associated.   The one exception is the mirror of BOTTOM which should be done just once.  

The problem with the mirror action is that the BOTTOM file does not get re-named in any way to 

give you confidence that it has been done and saved.  You depend on seeing its status on the main 

layout window where it will be obvious which orientation it is in.   If you doubt it in any way then 

delete it from the Project list and re-import from your PCB design package and reprocess the file 

through the various steps. 
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Milling the Board 

The following notes assume that the board is double sided, you have a symmetrical mirror on the 

BOTTOM file and you have at least one tooling hole that has been positioned and mirrored with 

consideration to the BORDER file outline. 

1 In order to protect your milling table you must first clamp a piece of sacrificial material 

to the milling table.   I use MDF as this tends to be quite uniformly flat.  It needs to be 

10mm minimum to give rigid mounting of the tooling pins. This board is clamped 

independently of the PCB material so the fixings must be outside the area that will be 

occupied by the PCB material. 

2 Cut a piece of PCB blank which must be oversize on the actual board geometry and make 

allowances for the tooling hole positions.  Mark on it two diagonal lines to indicate a 

rough central position.  Fix the PCB blank in place on top of the sacrificial board such 

that the milling machine spindle is at X0,Y0 and closely sat over the centre of the PCB 

material indicated by the crossing of the diagonals. Clamp the PCB material in place.  

This can be hard clamping or could just be using masking tape so long as you are 

confident it can’t move and is held flat to the sacrificial board. 

3 Zero the mill spindle Z0 to the top of the PCB material.  You could use a Haimer or active 

probe or you can zero each tool in turn using a thin sheet of paper under the tool end 

point. 

4 Load the Alignment Drills.nc file into the milling machine. 

5 Load the milling tool or drill specified for the tooling hole size and re-check that the tool 

measures to Z0 when just touching the top surface of the PCB blank. 

6 Check the cut Z reflects the depth of the PCB blank and 80% of the depth of the 

sacrificial material. 

7 Run the Alignment Drills.nc. 

8 This will create the two tooling holes or some other even number of holes depending on 

how many tooling hole positions you have chosen. 

9 Dust off the material and insert tooling pins into the tooling holes.  The PCB is now 

rigidly located on the sacrificial material which in turn is rigidly fastened on the milling 

table.   The PCB will need some extra fastening to make it as flat as possible on the 

sacrificial material.  

10 Load the TOP.nc GCode into the mill and install the chosen milling tool. Check Z0 to the 

top of the PCB blank. Run TOP.nc 

11 Repeat this for the DRILL.nc file with the correct tool loaded and after having checked 

Z0. 

12 When the above operations have been run, carefully lift the PCB blank from the tooling 

pins and turn it over either in X or Y.  This will depend on the Mirror axis you have 

chosen.  Fit the board back over the tooling pins and clamp it in place.  If you have 

followed the symmetrical mirroring instructions the PCB blank will sit in the same 

position over the tooling pins but now be bottom side upwards. 

13 Run the BOTTOM.nc GCode file to cut the bottom side artwork profile after having 

rechecked the tool Z0.    

14 Change the tool to a milling cutter as chosen in the Board Cutout section, zero the tool 

to the Z0.   Remember that the cutter is now cutting just through the PCB material so 

make sure the Z depth of cut is correct.  Run the PROFILE.nc.  This will leave tabs to keep 

the board fixed in place until the milling has finished.  

15 This completes the board and it can now be removed from the milling table and broken 

out of the PCB blank reading to use. 
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Default Settings and CNC Edits 

FlatCAM has the ability to save a set of preferred settings. As already mentioned, the Preferences 

section runs to 8 tabs.  It is somewhat daunting to look at so I have just done screen shots of my 

settings.  I should probably recommend that first of all you investigate the settings on these tabs and 

enter values that will suit your processing going forward.  This will speed up the processing of each 

file. 

Things to note : - 

General – set Units 

Gerber – set number of passes and standard milling tool diameter (0.127mm=5thou) 

Excellon – set drill depth and default drill size.  Fast retract in Adv Options. 

Geometry – set cut depth (0.127mm=5thou) and spindle speed. 

CNC Job – allows you to enter fixed header and footer GCode to your output files.  Very useful. 

Tools – (Huge tab !)  Set your default Cutout Tool and 2 Sided Tool. 

Tools 2 – nothing of major importance  

Utilities – nothing of major importance  

Once you save your Preferences these will load with every new job you process.   Note that FlatCAM 

updates are very frequent and you will find tweaks and mods continually being added.  I find it best 

to stick with a version that does what I need and not be tempted to upgrade.   There is a very good 

forum on the FlatCAM website for watching issues and problems. 

 

Milling Cutters 

You will have your own opinions on what is best to use to cut the PCB geometry.    

V bit cutters are the lowest cost and are readily available from overseas sources.  They can be fragile 

if you are using a narrow tip (5 to 10 thou) with a narrow V angle (10 degrees).  If you choose to use 

a narrow tip with a wide angle (45 degrees for instance) then small variations in board clamping 

flatness will lead to a wider and deeper cut into the PCB copper and substrate.  Depending on the 

artwork this may or may not be a problem.   

A simple exaggerated sketch of the problem is below.   
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The three V tools should be regarded as being at the same height and the board bowing up more on 

each one.  Underneath the board is a sacrificial material such as MDF so that through drilling does 

not damage the tooling table or the drilling tools.  It can be seen that the width of cut would change 

with the board flatness with respect to the tool tip. 

The ideal cutters to use are these with a short parallel section from the cutting edge before the taper 

section commences.  This eliminates width of cut variations but will not improve depth of cut 

changes.  Cutting too deep into the PCB substrate material will lead to more wear on the cutter than 

would be the case if just cutting copper. 

There are hybrids of both types available and I have found that the US supplier Think and Tinker 

have some very good tooling for PCB routing. 

 

Conclusion 

This write up is long and will need a number of readings and experimentation to understand the 

process.  There is repetition in the process which you will soon realise means a simple click to accept 

action as you go through the various stages and you will get quicker as a result.   

This is greatly improved if you spend time getting the Preferences set up to your satisfaction. 

I have spent many hours fine tuning my FlatCAM process and am now able to produce repeatable 

very fine artworks.  Here is a micro-USB pad array as an example.   

 

 

I hope this write up helps you achieve the similar results.  If it has been a help to you then please 

leave a comment in my blog www.altrish.co.uk or via email on subs999@altrish.co.uk 

 

  

http://www.altrish.co.uk/
mailto:subs999@altrish.co.uk
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Appendix A - Clamping the PCB blank and Coolant 

This is an ‘experiences download’ for you to cherry pick what suits you best.  There are various 

methods of clamping and the aim of each is to try to clamp the PCB blank as flat as possible on the 

tooling table.  As already mentioned any variations in the surface flatness will create a variation in 

the width of cut and depth of cut into the PCB copper surface and underlying substrate.   This is the 

most critical aspect of the process. Note that single sided PCB material is much more difficult to hold 

flat than double sided.  This is due to the asymmetric stress created by the one sided copper 

lamination process.  This leaves the board with a pronounced bow/set. 

Edging Strips or Fixed Frames 

Masking tape, double sided tape and some form of edging strips from metal stock are the simplest 

port of call for holding the PCB blank.  The downside is that as these strips clamp the edge, they can 

exert a downward pressure on the PCB edge and this in turn leads to an upward bow of the centre of 

the PCB blank.  This can be improved by having foam rubber strips on the edging strips to decouple 

the clamping action. 

If you have a matrix type tooling plate on your mill table you can have an open frame that matches 

the matrix and this can have foam decoupling also.  The frame should clamp down hard onto the 

table and have the correct spacing for the sacrificial board and the PCB thickness and an associated 

gap for the foam pressure pads. 

 

 

The following image shows my modifications to my original tooling plate frame.  As an aside, if you 

use a tooling plate make sure the Z movement heights allow for the depth of the frame and any 

screw heads.  
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With a clamping frame it is essential to make sure the mirror process is followed correctly to get a 

symmetrical flip or the frame will have to be moved to match the offset.  Clearly the board blank 

must also be a tight fit in the frame if this is the only reference.   Tooling pins are therefore still 

recommended. 

Floating Foot 

It is possible to buy or make a spring-loaded floating foot with ball bearing pressure points.  This sits 

on the spindle and creates downwards pressure on the PCB blank around the area that the tool is 

cutting.  I have 3D printed such a device for use on my CNCEST3040 mill and works very well.   It 

does need an appreciable amount of blank (wasted) PCB material beyond and bordering the artwork 

milling area.  It has ball transfer bearings on the lower surface which combined with the spring 

tension ensures the PCB is always pushed down flat around the area of the board being cut. 

I have yet to conceive a version of this for my Tormach 440 spindle. 
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Software Compensation 

There are various sources of software that will create a compensating adjustment of the Z cutting 

height.   The software requires a preliminary profile scan of the variations in height of the clamped 

PCB material.  This is done before the actual milling takes place and the profile variation file is added 

as a compensation to the actual cutting Z height defined in the Gerber file.   I am told this can work 

very well but does extend the manufacturing process timescale and if care is not taken it could 

potentially cause problems with side 2 alignments. 

Vacuum Table 

Currently this is my favourite method.  I modelled and machined an aluminium vacuum table using 

Fusion 360.   This is driven from a domestic vacuum cleaner acting as the suction source.  The table 

has a working area of 160mm x 100mm and is made from 15mm cast aluminium.  It has a 10mm x 

10mm matrix of 6.8mm holes with 1mm diameter suction holes at the bottom of each.  In operation 

it works very well with the PCB seen to ‘jump’ flat when the vacuum is turned on.   

Here is the Fusion model and the actual finished table.  This is showing the corner tooling pins and 

the central indexing mushroom tool mounted in the table and the secondary mushroom shaped 

tooling pins. 
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My tooling pins have a 6.8mm shank to fit into the vacuum plate matrix holes with 4mm protruding 

top section that engage with the sacrificial MDF layer and into the PCB.  Despite what you might 

think, MDF is very transparent to air circulation.   The vacuum will therefore suck the PCB material 

down onto the vacuum table through the MDF.  I use 3mm MDF. 

My operations with the vacuum table can take two routes. 

I can follow the FlatCAM process and have a sacrificial plate held in place with tooling pins in the 

plate corner holes with separate tooling holes in the PCB material that sit central in the vacuum 

holes and within the 100mm x 160mm operational area of the plate.  These pin locations are defined 

in FlatCAM as I have described. This was how I conceived it would work.  I then had one or two 

accidents with this method where I did not set the tooling hole location in FlatCAM to correctly 

coincide with the vacuum holes in the plate … much cursing. 

I now depart from locating the tooling holes in FlatCAM.  Instead, I have a standalone CNC program 

that is independent of FlatCAM that will drill 4 off x 4mm tooling holes in the PCB material and the 

MDF.  These are located at the four extreme corner holes in the vacuum table hole matrix.   These sit 

centrally within the area of the 6.8mm vacuum hole but are drilled just to the depth of the PCB 

material and the MDF. The location of these holes is referenced to the central hole in the vacuum 

plate such as to be +/- 50mm in Y and +/-80mm in X.  

This referencing needs to be accurate if the vacuum plate is not going to be damaged when drilling 

the tooling holes.  To achieve this, I have a ‘mushroom’ that has a 6.8mm shank that sits in the 

vacuum table central hole.  The top cap of the mushroom, which is 25mm diameter, is probed in X 

and Y to set the exact location of the centre hole. 

Let’s review this.   Four holes at 4mm diameter passing through the PCB and the MDF that are 

located in the most extreme holes in the vacuum table grid of holes.  The tooling pins have a 6.8mm 

shank and a 4mm post.   This means the PCB and the MDF are locked together on the same pins. 

If I lift the PCB up off the vacuum plate and the tooling pins, I can flip it over in a horizontal or 

vertical plane.  In the horizontal flip the centre line of holes in the vacuum table are always going to 

be at the centre of the flip (the hinging line if you like to call it).   Similarly, a flip on the vertical line 

will also leave the hinging line in the strip of centrally placed vertical holes. 

Providing my PCB has been exported with 0,0 as the centre point of the Profile then I can place the 

PCB centre point on the vacuum plate on any one of the central horizontal or vertical lines of holes.  

The end result of this is I can pre-cut standard size pieces of PCB and MDF that completely cover the 

vacuum plate holes and have the standard 4mm holes already drilled at +/-80mm, +/-50mm from 

the centre point. 

I can now ‘move’ the PCB geometry to have its central X0Y0 at any position on the horizontal or 

vertical centre line of holes.  This makes the unused parts of the PCB reusable given appropriate 

geometry of a new board. 

My vacuum table is very tolerant of uncovered holes not leading to a loss of vacuum.  If the previous 

board milled has left a large opening in the PCB blank, I simply tape over any such apertures to 

regain full vacuum strength. 
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With regards to referencing, I only need to initially reference the centre hole on the vacuum table on 

the mill.  This becomes 0,0 as the initial working coordinates.   You could regard this as G54.   I can 

then use the machine readout to step along left/right or up/down in 10mm steps along the cross 

axis of central holes to choose a new location for the next board’s 0,0 position.  Once chosen I then 

re-reference the spindle.   I could be really clever and call the new position G55 but there might be 

something in the exported G code from FlatCAM that would override this back to G54 and disaster 

would strike. 

If I do not use this method but instead have the PCB material separately clamped on the MDF then 

my tooling pins are also mushroom shaped.   As I am only using 3mm MDF there is the potential for 

simple pins to sway and not remain vertical with respect to the PCB surface.  This would lead to 

alignment errors between top and bottom artwork milling. By having mushroom shaped pins with a 

top hat section, they can be pushed down flat onto the PCB surface and maintain the vertical 

alignment.  

Here are two images of the two setups. The first image shows the PCB tooling pins located via 

FlatCAM and independently positioned from the MDF tooling pins. The second image shows the PCB 

and MDF both using the same tooling pins where the tooling pin location is done via CNC and not 

FlatCAM. 

  

 

Coolant 

My Tormach 440 has a FogBuster mist coolant system.   Having this running with a very fine mist 

spray appears to help the milling process.  The coolant must help lubricate the cutting tip and the air 

blast removes the swarf.  The coolant dampens the swarf dust. The coolant also flows into the 

geometry cut traces and as a result these appear darker during the milling process and are more 

obvious to inspect as the milling progresses.   Note however that the coolant will be absorbed by the 

MDF and cause it to swell. This will degrade the flatness of the MDF so it can only be used for one 

PCB run before disposal and certainly not left overnight to continue a run next day.  An alternative 

manually applied lubricant could be a diluted washing up liquid dabbed on with a paint brush. 


